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Starting iProcess
This section explains how to run iProcess on your client computer.

• Logging into iProcess

• Changing Your Server Password

• Keyboard Use

• Exiting iProcess

Logging into iProcess
To log in to iProcess:

Procedure

1. Click Start, point to Programs and then to the iProcess sub-menu. (By default this is 
called TIBCO iProcess Workspace (Windows).)

2. Click TIBCO iProcess Workspace (Windows).

The TIBCO iProcess Workspace (Windows) Login dialog box is displayed. This dialog 
prompts you for the following information:

Box Description

User Enter your iProcess username.

Password If the iProcess Engine node you have selected is set up to require 
password entry, you should enter your password (on the iProcess 
Engine computer) here. 

If the Password box is not available, click Browse, then ensure that 
your iProcess Engine is selected from the list.

Server Select iProcess Engine you want to log in to from the drop-down list
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Box Description

Click Browse to update the drop-down list with iProcess Engines that 
you commonly use. You are taken to the Browse iProcess Engines 
dialog box.

3. When you have entered the correct information, click OK to log in.

If you cannot log in, try the following:

• If you are logging into an iProcess Engine node for the first time, check that the 
computer name where the iProcess Engine node is installed is in your hosts file. 
(The location of this depends on your client/network type. If you are unfamiliar with 
this file, ask your system administrator for help.)

• You may not be a valid user on the iProcess Engine node, or you may have entered 
the wrong (or no) password in the box (if enabled).

• TIBCO iProcess Workspace (Windows) is unable to access the iProcess Engine node. 
You need to enable the access from iProcess Workspace (Windows) to iProcess 
Engine by configuring the RPC_BLOCK attribute. For more information about this 
issue, see "Administering Process Attributes" in TIBCO iProcess Engine 
Administrator’s Guide.

After login, you are taken to the Using Work Queue Manager for full details.

Note: If the iProcess command line includes a tool parameter, you will be taken 
directly to that function instead. See “Starting and Configuring iProcess From 
the Command Line” in TIBCO iProcess Workspace (Windows) Manager’s Guide for 
more information.

Using the Browse Dialog
This dialog enables you to update the server drop-down list of the TIBCO iProcess 
Workspace (Windows) Login dialog with iProcess Engines that you commonly use.

After a few seconds, you are shown a list of all the active iProcess Engines on your 
network, plus any others that are already selected.
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Column Description

Server This is the server computer name.

Service No. This is the RPC service number, which distinguishes between 
different iProcess Engines on the same computer.

Description This consists of the iProcess Engine nodename, followed by the 
iProcess licen name.

Select or de-select iProcess Engines required (by clicking the mouse on the items, or with 
the ARROW keys and SPACEBAR to select), then click OK to close the dialog box.

Note: To ensure the browse list is up to date, de-select all iProcess Engines, 
click OK, then Browse again. 

Changing Your Server Password
To change your password on the server you are connected to:

Procedure

1. From the Work Queue Manager, click Tools > Change Password.

The Change Password dialog box is displayed.

Note: This dialog box is displayed automatically if you attempt to log in when 
your password has expired.

2. Fill out the boxes in the dialog as follows:

Box Description

Old password Enter your current password. (If you have forgotten your 
current password, you will have to ask your system 
administrator to change your password on the server 
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Box Description

directly.)

New password Enter your chosen new password. This password must 
conform to the requirements of your server’s operating 
system.

Confirm new password Enter your chosen new password again.

Note: Passwords are not displayed when you type them - they appear as 
asterisks instead.

3. Click OK. You must use the new password when you next log in or use an electronic 
signature on a form.

If you encounter problems trying to change your password:

• Read any error message that is displayed. This will probably indicate the cause of 
the problem.

• Passwords are usually case sensitive, so check that your CAPS LOCK key is off.

• Did you enter your current password correctly?

• Is the new password sufficiently different from the current one?

• Try entering a longer new password.

• Try mixing digits and letters, or use mixed case letters.

If you still cannot get iProcess to accept your new password, contact your system 
administrator for further assistance.

Keyboard Use
Although use of the mouse is usually more convenient, all aspects of iProcess can be 
controlled from the keyboard. 

• Your operating system help and/or user documentation should describe the 
standard keys for using menus, dialog and list boxes etc.
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• Some of the menu options have keyboard shortcuts noted on the right hand side of 
the menu which may be used as an alternative.

• Some buttons and other controls may have an underlined character; as an 
alternative to pressing the button, ALT+ the key for the underlined character may be 
pressed.

• A button surrounded by a dark line is the default option and will be chosen by 
pressing ENTER; the default may be moved by TAB and SHIFT+TAB.

• An object in a window (button, list box or field) can also be in focus, meaning that it 
is responsive to keyboard entry. TAB and SHIFT+TAB may be used to move the 
focus, usually shown by a surrounding dotted line, flashing cursor or highlight.

Exiting iProcess
To exit iProcess:

Procedure

1. Click Close from the Work Queue Manager window. 

2. Confirm in the Exit TIBCO iProcess dialog - if you have any active iProcess windows, 
you may be asked to close them.

Note: If you select the Save Changes check box, the settings on the Options 
menu will be saved.

You can also log out of iProcess externally. See “Starting and Configuring iProcess From 
the Command Line” in TIBCO iProcess Workspace (Windows) Manager’s Guide for more 
information about using iProcess command line parameters.
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Using Work Queue Manager
The Work Queue Manager gives quick on-screen access to your outstanding work. It is the 
main window you are taken to after logging in to iProcess Workspace on most 
installations.

Getting Started shows you the basics of how to use Work Queue Manager to start major 
iProcess functions and process your work items. It describes the window areas, menus, 
buttons and icons you will see when using it.

The remaining sections in this section explain the features provided by Work Queue 
Manager, which enable you to manage your work queues simply and effectively:

• Getting Started

• The Work Queues List

• The Work Items List

• Participant Records List

• The Status Bar

• Menus and Toolbar Buttons

Getting Started
When you log in to iProcess Workspace, the Work Queue Manager starts automatically. 
The Main Work Queue Manager window is displayed. (The window could be minimized as 
a button on your taskbar.)

The window is divided into two parts:

• The work queues list, on the left hand side of the window, shows the list of work 
queues you have access to. 

• The work items list, on the right hand side of the window, shows the work items in 
the currently selected queue.
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Tip: To change the size of either part of the window, drag the bar that 
separates the two sides.

The Work Queues List
The work queues list, on the left hand side of the window, lists all the work queues that 
you have access to. To make them easier to find, queues are organized into the following 
folders:

• The User Queues folder, containing your personal work queue , which only you 

can access. (Even iProcess administrators cannot access your personal work queue.)

If you are logged in as the iProcess Administrator user, swadmin, this folder may 
also contain an undelivered mail queue.

• The Group Queues folder, containing group work queues . All users who are 

members of the same group can work on that group queue. 

• The Test Queues folder. This folder is only displayed if you are a user who is 
allowed to define iProcess procedures. It contains:

—  test user queues for any unreleased procedures. 

—  test group queues for any unreleased procedures. 

• The Queues Administration folder - If you are a Queue Supervisor, you will have a 
folder containing the queues you are supervisor of.

Note that:

• Queues may also be sorted by queue description if this option has been set by your 
system administrator.

• You may sometimes see a Rebuild Queues button at the top of the work queues 
list. See Rebuilding the Work Queues List for more information about this button.

• When you select a work queue you may occasionally see one of the following error 
messages.
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If you see this message... Do this...

Work queue not responding Click OK. The queue gets grayed out. This means 
that the work queue server has temporarily failed. 
Try selecting another queue before selecting this 
queue again. If the queue is still unavailable, 
contact your system administrator.

The Work Item Server (WIS) is 
fetching the work items for this 
queue. Please wait...

Wait for the list of work items to appear. How 
long this takes will depend on the size of the 
queue and the load on your system. If this 
message continues to be displayed and the list of 
work items does not appear, contact your system 
administrator.

Queue Status Indicators
Work Queue Manager provides several indicators to let you easily see the status of a work 
queue, library, procedure or sub-procedure. You may see these indicators either on their 
own or in combination on any work queue, library, procedure or sub-procedure.

Indicator Description

A yellow envelope on top of an icon means that the queue contains work items 
that have not yet been opened.

A yellow circle with an arrow on top of an icon means that the queue contains 
work items that have deadlines. 

A red exclamation mark to the right of a queue name means that the queue 
contains urgent work items.

User/group queues with active redirection are shown with a red arrow attached 
to the right side of the icon.

Redirected queues in the Queue Administration folder are shown with a  

attached to the right side of the icon, plus  to the right of the description, or 
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Indicator Description

 if the redirection is currently active, plus the destination queue name.

If a queue icon is animated - blinking on and off - something has changed 
since you last opened the queue or updated its work items list. For example, a 
new work item has arrived or a deadline has expired. Clicking the animated 
icon updates the work items list for the queue.

Setting Work Queue Manager Options explains how you can set up which 
events cause a work queue icon to animate.

Note: 
If the queue is not visible the animated page appears on top of the parent 
folder instead, so that you can see that something has changed in one of its 
queues. 

The Work Items List
If a Work Queue is highlighted on the left, the area on the right hand side of the window 
lists the Work Items in the current Queue. By default, the following information is shown 
about each work item:

• its Case Description and Case Reference.

• its Status. See Work Item Status Indicators.

• the Form Description which will appear when the work item is opened.

• any Deadline attached to it:

•  A yellow circle with an arrow indicates a deadline which will expire on the date 

and time shown.

•  A red circle with an arrow indicates a deadline which has already expired on 

the date and time shown.

You can tailor the information displayed about each work item to individual queue 
requirements. See Organizing Your Work Items Lists for more information. 



TIBCO iProcess® Workspace (Windows) User Guide

14 | Using Work Queue Manager

Tip: You can change the order in which columns are displayed by clicking in a 
column heading, dragging it left or right to a new position and releasing it. You 
can change the width of a column by dragging the right hand border of the 
column left or right until it is the size you want.

Work Item Status Indicators
A work item’s status is shown visually using the following indictors.

Indicator Description

A yellow envelope means that the work item has not been opened 
since it arrived in the queue. (The work item text is also shown in blue 
to indicate this.)

A white page means that the work item has been previously opened 
and kept.

A grey page means that the work item cannot be opened because it 
belongs to a case that has been suspended.

An envelope with a red arrow means that the work item can be 
released directly from the work queue. See Releasing Work Items 
Directly from a Queue.

A padlock means that the work item is locked and cannot be accessed 
- usually because somebody has it open already. The work item text is 
also shown in gray to indicate this. (An item’s lock status is updated 
automatically - see Updating Your Work Queues.)

A red cross through an icon means that the work item is not available 
- you may see this on a work item which another user has already 
released.
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Indicator Description

Note: You may also see the following indicators in combination with any of the 
above:

A red exclamation mark to the side of an icon means that the work 
item is urgent. See Work Item Priorities.

Work items awaiting redirection are shown with a red arrow to the 
right of the status icon, and the text is grayed out.

Work Item Priorities
Work items are given priority values when they arrive in a queue. Priority values range 
between 1 (the highest) and 999 (the lowest):

• A work item’s priority may change over time once it has arrived in a queue. (The 
procedure definer determines whether or not a work item’s priority escalates in this 
way.)

• You can display work item priorities, and use them to sort, filter or find items in 
your queues. See Organizing Your Work Items Lists.

• A work item will be marked as urgent if its priority value is equal to or less than a 
specific value. By default this value is 10, but the iProcess administrator can change 
it as required for individual queues.

Participant Records List
If an Administration Queue (a queue in the Queue Administration folder) is highlighted on 
the left, the area on the right hand side of the window lists the Participant Records for the 
current Queue.

A Participant Record consists of information about which Users can be Participants in a 
Queue and for what period(s). The following information is shown about each Participant 
Record.

• Participants. This is a list of users who have access to the current queue.
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• Active Time. This shows the date(s) and time(s) when access is possible for the 
listed users.

Tip: You can move or resize the columns by using the mouse to click and drag 
the headings.

The Status Bar
The status bar provides summary information about the currently selected folder or work 
queue:

• If a folder is selected, the status bar shows the name of the folder and the number 
of queues it contains.

• If a work queue is selected, the status bar shows the following information.

Status Bar Component Description

Name of the currently selected queue.

Total number of work items in the queue.

Number of urgent items in the queue.

Number of unopened items in the queue.

Number of items with deadlines in the queue.

Number of the currently selected work item.

Status messages are sometimes shown. This example 
shows that a filter is applied to the queue. 

Note: All counts are made according to this filter.
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Menus and Toolbar Buttons
The options from the Tools menu (and the set of buttons on the left hand side of the 
toolbar) correspond to the major iProcess functions available to you, depending on your 
system configuration and user type. (Some also require extra software installed on your 
computer.) The following sections describe the full set of options (organized by menu):

• Tools Menu

• Window Menu

• Queue Menu

• Work Item(s) Menu

• Procedure Management Menu

• Options Menu

• Help Menu

Note 

Keyboard shortcuts are also available. To see what a keyboard shortcut is, 
select the menu option or rest your pointer over the button.

Tools Menu
The following table describes the menu options and their associated icons for the Tools 
menu.

Option Button Description

Case Start Enables you to start a new case of a main 
procedure. See Starting Cases.

Case
Administration

Enables you to perform case administration tasks 
such as closing cases, purging cases and 
examining the audit trail for a particular case of a 
procedure. See “Administering Cases” in TIBCO 
iProcess Workspace (Windows) Manager’s Guide 
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Option Button Description

for information about administering cases.

Process 
Administrator

Enables you to create or edit users, groups, roles, 
attributes, lists or tables; purge or close cases and 
initiate the Move Sysinfo process to update iProcess 
data.

See TIBCO iProcess Workspace (Windows) 
Manager’s Guide for more information.

EIS Reports Runs an Executive Information Service (EIS) Report, 
either directly or via a selection dialog. See 
“Reporting on Case Data” in TIBCO iProcess 
Workspace (Windows) Manager’s Guide for more 
information.

The third party data viewer must be installed on 
your computer to use this.

RunStep Opens a form window of a particular step of a 
procedure without starting a case (a caseless 
form). See Caseless Forms.

Queue 
Monitor

Starts TIBCO iProcess Monitoring.

See TIBCO iProcess Monitoring User’s Guide for 
more information.

Note: You must have TIBCO iProcess Monitoring 
installed on your computer.

Change 
Password

None This command enables you to change your 
password on the Server your client is connected to. 
See Changing Your Server Password.

Window Menu
The following table describes the menu options and their associated icons for the Window 
menu.
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Option Button Description

Create New 
Work Queue 
Window

Create a new Work Queue Manager window. See Using 
Multiple Work Queue Windows.

Work Queues 
Charting Mode

Switch between the work items list and loading chart. 
See The Loading Chart.

Queue Menu
The following table describes the menu options and their associated icons for the Queue 
menu.

Option Button Description

  Update the work items list for the current work 
queue. See Updating Your Work Queues.

Update Updates the list of Participant Records for the 
currently opened Administration Queue.

Change Access 
Criteria

View or change the sort, filter or display 
options for the current work queue. See 
Setting Sort, Filter, and Display Options.

Administration See below Takes you to a submenu with the following 
options. This is only available if you are a 
Queue Supervisor.

Administration > 
Add Participant 
Record

Adds a Participant Record to the currently 
selected Administration Queue. See To Add a 
Participant Record.

Administration > 
Modify Participant 
Record

Enables you to modify the currently selected 
Participant Record. See To Modify a 
Participant Record.
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Option Button Description

Administration > 
Delete Participant 
Record

Deletes the currently selected Record (after 
confirmation).

Administration > 
Redirect Work Items

Enables you to redirect all Work Items for the 
currently selected Administration Queue. See 
Redirecting Work Items.

Administration > 
Unlock Participant 
Record

None (iProcess Administrator user only) Forcibly 
unlocks a record which has been left locked 
accidentally. See To Unlock a Participant 
Record.

Rebuild Queues List Forces the queues list to be rebuilt. See 
Rebuilding the Work Queues List.

Work Item(s) Menu
The following table describes the menu options and their associated icons for the Work 
Item(s) menu.

Option Button Description

Open Open the currently selected work item. See 
Opening and Processing a Work Item.

Open First/Next 
Unlocked

Open the first (or using the CTRL key, the next) 
unlocked work item in the work items list. See 
Locked Work Items.

Release Release the currently selected work item(s) 
directly from the queue. See Releasing Work 
Items Directly from a Queue.
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Option Button Description

Forward Forward the currently selected work item(s) to 
another user. See Forwarding Work Items from 
a Queue.

Find Find a particular work item in the current queue. 
See Finding Particular Work Items.

Procedure Management Menu
For a description of the Procedure Management menu options, see “Standard Toolbar 
Buttons and Menu Items” in TIBCO iProcess Modeler Procedure Management.

Options Menu
The following table describes the menu options and their associated icons for the Options 
menu.

Option Button Description

Font Change the font used in the Work Queue 
Manager window. See Changing the Display 
Font.

Window Options View or change your current work queue 
window, animation or notification or Procedure 
Management options. See Setting Work Queue 
Manager Options.

Form Window None Choosing this command gives a submenu with 
the following options, which take you to 
standard dialogs affecting all forms:

• Select Font
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Option Button Description

• Select Background Color

• Select Text Color

Always on Top None When ticked, the Work Queue Manager will be 
always be on top of other open windows.

Case Start Auto-
Repeat

None When ticked, specifies that the Case Start Dialog 
should reappear after a successful Case Start.

Auto-Repeat 
Open Work Item

None When ticked, after you release a form the first 
available work item in the queue is opened.

Help Menu
 

Option Button Description

various Display iProcess Help.

Personalizing Work Queue Manager
This section explains how you can personalize Work Queue Manager to suit the 
workstation you use and your personal preferences. See:

• Changing the Display Font 

• Setting Work Queue Manager Options 

Tip: Whatever options you set are saved when you log out of iProcess 
Workspace (Windows) and used again when you next log in.
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Changing the Display Font
To change the font, style or size of text displayed in the current Work Queue Manager 
window:

Procedure

1. Click .

The Font dialog box is displayed.

2. Select the font, style, size and script you want to use and click OK.

Note: Any new Work Queue Manager windows you open will use these settings. 
Any existing windows are not affected. (If, on the other hand, you wish to 
change the font for the Form window, click Options > Form Window.)

Setting Work Queue Manager Options
To change the events which animate a work queue icon, how and when you are notified 
about new work items, or some general window options:

Procedure

1. Highlight the a folder or queue in the Work Queue List. 

2. Click .

The Work Queue Manager Options dialog box is displayed. 
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3. Select the options you want to use (as shown in the following table) and click OK.

Option Description

Minimize Window on 
startup

Set this option to control how the window appears when 
you login to iProcess Workspace:

• Select this box if you want the window to appear 
minimized.

• Leave it blank if you want the window to reappear in 
the same size and position it was in when you logged 
out.

Minimize Window on 
work item open

Select this box to minimize the window when you open a 
work item.

Tool Bar Button Size Use the arrow buttons (or enter a value) to make the toolbar 
buttons proportionately larger or smaller.

Dynamic drag-scroll Set this option to control how you scroll through work item 
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Option Description

display in work item list lists which are too big to fit in the window:

• Select this box to update the work item list 
dynamically when you drag the scroll bar slider. (This 
is the recommended option if you want to be able to 
browse through large queues.)

• Leave it blank if you want the work item list to 
update only when you release the slider (which is 
faster).

New items arrive Select this box to animate a work queue’s icon when new 
work items arrive.

Work items are removed 
or released (by other 
users)

Select this box to animate a work queue’s icon when other 
users in a group queue remove or release a work item.

Work item deadlines 
expire

Select this box to animate a work queue’s icon when a 
deadline expires on a work item.

New or existing items 
have become urgent

Select this box to animate a work queue’s icon when a new 
item arrives which is urgent, or when an existing item 
becomes urgent. See Work Item Priorities.

Work item priorities or 
variables have changed

Select this box to animate a work queue’s icon when an 
existing work item’s priority value, case description or work 
queue field changes.

Check for new work 
period

Use the slider controls (or enter a value) to set the interval 
between automatic queue refreshes. See Managing Your 
Work Queues.

Play Sound when new 
work arrives

Select this box if you want Work Queue Manager to play a 
sound when a new work item arrives in a queue. 

Sound If you have the appropriate hardware and want to use a 
different sound from the default system bleep specify the 
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Option Description

pathname of a .WAV file. You can use the Browse button to 
locate an appropriate file and the Test button to test the 
sound.

Show Dialog when new 
work arrives

Select this box if you want Work Queue Manager to display 
the New iProcess Work Has Arrived dialog when a new 
work item arrives in a queue. This dialog lists all the queues 
which have just received new work items. A Go To Queue 
button enables you to select a queue and jump to it to view 
the updated work items list.

Only notify when all 
work queue manager 
windows are inactive

Select this box if you want to be notified of new work (by 
sound and/or dialog) only if you are not already working in 
a Work Queue Manager window.
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Processing Work Items
This section explains how to process your work items. 

• Starting Cases

• Opening and Processing a Work Item 

• Releasing Work Items Directly from a Queue 

• Forwarding Work Items from a Queue 

Starting Cases
A case is an instance of running an iProcess procedure. To start a new case of a 
procedure:

Procedure

1. Click the Case Start tool  from the Work Queue Manager window. The Case 
Start dialog box appears.

2. In the Procedure Type section of the dialog, make sure you select Released. All 
available procedures of that type are listed (along with the version number). For a 
description of the Model and Unreleased buttons, see “Testing Procedures” in 
TIBCO iProcess Modeler Procedure Management.
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3. Either click one of the procedures in the list, or enter its name in the Procedure text 
box.

Note: You can only start cases for a main procedure. You cannot start cases for 
sub-procedures.

4. Enter some text for reference in the Case Description box (unless Case Description 
is grayed-out).

5. Click Start to start the case.

Tip: If you are starting several cases in succession, click Options > Case Start 
Auto-Repeat from the Work Queue Manager window. This will return you to the 
Case Start dialog after each successful case start (until you click Cancel).

Caseless Forms
Caseless forms is a facility that enables you to open the form window for any step of a 
procedure without starting or accessing a case.

If you have a Runstep command tool  like the one on the left in your Work Queue 
Manager window, choosing it will open a specific caseless form as set up by your system 
administrator.

Opening and Processing a Work Item
Procedure

1. Double-click an (unlocked) work item in the work items list to open it.

A Form window is displayed, containing a form for you to fill in. 

2. When you have finished working on the form, click File > Exit and either:

— release the work item back to iProcess Engine for further processing. The work 
item disappears from your queue.

— keep the work item in your work queue so that you can work on it again. Any 
information you have entered into the form is saved.
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For more information about filling in forms, see Filling in Forms.

Locked Work Items
A work item, which is shown in gray, with Status  is locked. This means that you cannot 

open it because somebody already has it open. (Locking prevents two people from 
working on the same work item at the same time.) You will see locked work items in two 
situations:

• When you open a work item its status immediately changes to locked, and remains 
so until you keep or release it.

• When you are working in a group queue, items that other users are currently 
working on are shown as locked. 

Work Queue Manager automatically updates the lock status of work items (see Managing 
Your Work Queues). You can see work items in group queues changing between locked 
and unlocked as other members of the group work on them.

Tip: When you are working in a large or busy group queue, rather than search 
for an unlocked work item to open you can simply click  to open the first 
unlocked item in the queue. (If you hold down the CTRL key at the same time 
you open the next unlocked item from where you are in the queue.)

Releasing Work Items Directly from a Queue
If a work item’s form simply displays information (that is, it does not contain any fields for 
you to fill in) you can release it directly from the queue, without opening it first. 

Such queue releasable items are shown with Status . New items (with status ) may 

also be releasable, in which case the  button is shown as available when you click the 

item.

The ability to directly release items in this way is useful if, for example, you receive large 
numbers of ‘for information only’ copies of work items completed by other users.

To release a work item directly from a queue:

Procedure
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1. Click the work item you want to release. If you want to release several work items, 
hold down the CTRL key and click each additional one.

Tip: If you want to select a block of work items, click the first item, then hold 
down the SHIFT key and click the last item.

2. Click .

The Release Work Item(s) dialog appears.

3. Click Yes to confirm that you want to release the work items.

The work items are released and disappear from your queue.

Note: When you release a work item directly from a queue, any initial and 
release scripts associated with the work item are not run.

If you accidentally select a group of work items which includes one or more that cannot be 
released, the Release Work Item Problem dialog appears. This dialog identifies the work 
item which can’t be released, and enables you to either skip this item and continue, or 
stop releasing items at this point.

Tip: Sort your queue by Queue Releasable Items to make it easy to select a list 
of items to release in a single operation. See The Work Queue Sort Criteria 
Dialog.

Forwarding Work Items from a Queue
You may be able to forward certain work items from your queue to other users. 
Forwarding enables you to pass a work item on to another queue without progressing the 
case.

The procedure definer determines whether or not a particular work item can be 
forwarded when they set up a procedure. For example, a procedure may be set up which 
sends all new work items for a group queue to a supervisor, who can then forward them 
on to different people in the group, according to their current workload.
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Note: Whether you as a user can forward work items also depends on the 
setting of your USERFLAGS attribute - see “Managing Users” in TIBCO iProcess 
Workspace (Windows) Manager’s Guide.

To forward a work item to another queue, perform the following steps:

Procedure

1. Click the work item you want to forward. If you want to forward several work items 
(to the same user), hold down the CTRL key and click each additional one (or 
extend the selection by holding down the SHIFT key).

2. Click . (If the item cannot be forwarded this button is not available.)

• The Forward Work Items dialog appears. From the list shown, select a queue to 
forward the work item to and click Forward.

Select the Restrict list to ONLY show queues that you are a member of check box 
if you want to list only those group queues which you are a member of. If you leave 
the box blank, all user and group queues are listed. 

Note that:

— you cannot forward work items to test queues or (if you are logged in as an 
iProcess Administrator user) to the Undelivered Work Items queue. 
Consequently these queues are never listed.
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— the current setting of this box is saved when you log out and used when you 
next log in.

Alternatively, you can use drag and drop forwarding:

Procedure

1. Click the work item you want to forward to highlight it (or select multiple items by 
holding down the CTRL or SHIFT keys as described above).

2. Drag the highlighted work item(s) with the mouse to one of the Work Queues in the 
list on the left hand side of the window.

Note: You can drag a work item between different Work Queue Manager 
windows, provided they belong to the same client session.

In either case, the items are forwarded to the selected user and disappear from your 
queue.

If you accidentally select a group of work items which includes one or more that can’t be 
forwarded, the Forward Work Item Problem dialog appears. This identifies the work item 
which can’t be forwarded, and enables you to either skip this item and continue, or stop 
forwarding items at this point.
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Filling in Forms
This section shows you how to fill in the form of a work item when opened from a work 
queue or when you start a case. 

• Opening a Form 

• Completing a Form 

• Closing a Form 

• Using Other Field Types 

• Field Editing 

• Copying a Form 

• Printing a Form

Opening a Form
You can open a form in two ways:

• By double-clicking on a work item in a work queue (see Processing Work Items).

• By starting a case (see Starting Cases).

In both instances you are presented with a Form Window on your screen.  

Completing a Form
This section describes how to complete a form. It discusses:

• entering information into fields

• field types 

• field origins 

• drop down lists 



TIBCO iProcess® Workspace (Windows) User Guide

34 | Filling in Forms

• field help 

Entering Information into Fields
When you open a form that has one or more fields that you can fill in, the cursor is 
automatically placed on the first field.

To enter information:

Procedure

1. Type the information in the field.

2. Press Return or Tab to move to the next field.

Note: Some forms, such as a letter, may only display information and will not 
have any fields to fill in.

Field Types
The information that you enter into a field depends on the field type:

Field Type Characteristics of Input Example

Text Any characters. 56 Bath Crescent

Numeric +/- numbers with decimal 
places where specified.

6050.75

Date By default, dd/mm/yyyy, but 
your System Administrator can 
change this.

24/10/1998

Time 24 hour clock. 17:01

Memo Field Large amounts of text. See MemoFields 

Application Field No input is allowed. See Application Fields 
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If you try to enter the wrong kind of information, such as text in a numeric field, it is not 
accepted by iProcess.

Field Origins
Fields are shown in different ways depending on what you need to do with them. This is 
called the Field Origin:

Origin Displayed as Action

Required Red, turns to white 
when filled.

You must complete this field before you can 
Release the work item.

Optional White You can enter information into this field but you 
do not have to.

Display White This field is for information only. You cannot 
enter information into it. The information will 
have been entered in a previous step or by abox 
file or calculated by the procedure.

Drop-down Lists
A field that has a selection of responses that you can choose from is shown with a drop-
down list:

To select an item from the drop-down list, click the appropriate item. 

Alternatively, typing the first letter of the item takes you to the first entry beginning with 
that letter. 

Where a range is specified e.g. 1000 to 2000, enter a number within the range.

When the list is displayed with a blank field, you can enter any value into the field and it is 
automatically added to the list.
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Field Help
Some fields have help information provided by the procedure definer.

When a field has a  button next to it, click the button to see the help for the field.

Closing a Form
You can close a form by either Keeping it or Releasing it. 

• Keeping a form returns the form to your Work Queue and you can open it again 
later to continue working on it. 

• Releasing a form removes the Work Item from your queue and allows the case of 
the procedure to progress to the next step. You Release a form when you have 
finished working on it.

Note that:

• You cannot Release a form until you have completed all of the Required fields.

• If you have a work item open and the work queue server fails for any reason, you 
can keep or release the item but the effect will always be to keep the work item. 
When the work queue is working again, you can go back to the work item and then 
release it.

• If you see the following error message when you try to keep or release a work item:

Error case data updated elsewhere since item opened. Please open item and edit 
it again.

It means that iProcess Engine has updated the work item with new data since you 
opened it. This means that you are, effectively, working on an out-of-date copy of 
the work item. As a result, your keep or release instruction is ignored. The work 
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item is returned to your queue with the changes made by iProcess Engine, but any 
changes you made to the work item are lost.

Keeping a Form
To keep a form, double-click the Keep icon  on the status bar. The Work Item is 

returned to your queue. You can re-open the form at any time.

Note: 
• TIBCO iProcess Engine can update some or all of the field values in a 

work item while it is in your queue. The server will do this if, for example, 
new data relevant to the work item has been received from another 
system. If this happens, you may not see the field values you expect when 
you next open the form.

• If a case is suspended while you have the work item open, and you keep 
it, any changes you have made are lost. (Cases can only be suspended by 
SPO or SAL applications.)

Releasing a Form
Once all of the Required fields have been completed, the Release icon  on the status 

bar is enabled with a yellow envelope displayed. Double-click this icon to release the form. 
This case then moves on to the next step in the procedure.

Tip: If the Release icon is not enabled (grayed-out), check that all Required 
fields have been completed and that you have tabbed off or pressed <Return> 
on the last Required field.

Using Other Field Types
This section explains how to use:

• MemoFields
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• Application Fields

MemoFields
A memo field is a text field that enables you to enter a large amount of information. 

 A memo field in a form is indicated by this icon. Where the paper on the right 

is blank, the memo field is empty.

 When the paper has writing on it, the memo field contains information.

To Open a Memo Field

Click the field to open the memo.

To Complete a Memo Field

Enter your information within the memo. You may enter as much or as little information 
as you need.

To Save a Memo Field

Procedure

1. Click the Exit button. You are asked if you would like to save your changes.

2. Click Yes to save the memo. Click No to discard your changes.
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Application Fields
Application fields are used in a form to call another Windows application or an iProcess 
expression or script. The field appears as a button which, when clicked, runs the 
application. 

The button can have an icon and/or a description or neither:

•  Icon and description. Clicking this opens Windows Notepad. 
(Clicking it twice runs Notepad again - not the same one).

•  Icon only. Clicking this opens Microsoft Excel.

•  This button appears when there is no icon or description.

Field Editing
You can cut, copy and paste field contents from one field to another and you can undo 
your editing.

Operation Description

Cut To cut, select the field contents you want to delete and click Edit > 
Cut.

Copy To copy, select the field contents you want to copy and click Edit >  
Copy.

Paste To paste, select the field you want to paste into and click Edit > 
Paste.

Undo To undo the last key stroke in a field, click Edit > Undo.

Undo All To undo ALL the changes you have made to a form in this editing 
session, click Edit > Undo All. You will be asked to confirm that you 
want to undo all changes. Click Yes to undo or No to keep your 
changes.

Note: You cannot undo an Undo.
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Copying a Form
You can copy the form (fixed text and fields) to the clipboard so that it can be pasted into 
another application such as a word processor.

To copy the form, click Edit > Copy All.

Note: This option is only available if the form has been given Edit permission by 
the procedure definer.

Printing a Form
To print the form click Form > Print. The standard Windows Print dialog box is displayed. 
Select the options you want and click OK.
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Organizing Your Work Items Lists
This section explains how you can organize and search your work items lists so that you 
can easily find the information you need when you need it. 

• Setting Sort, Filter, and Display Options 

• Finding Particular Work Items 

Setting Sort, Filter, and Display Options
A default set of sort, filter and display options are defined on iProcess Engine. These 
defaults control the way your queues are displayed in Work Queue Manager. If these 
defaults do not suit you, you can customize them for individual queues.

To set sort, filter or display options for the current work queue:

Procedure

1. Click . The Work Queue Access Criteria dialog box is displayed.

2. Click:

— Sort to define the order in which work items are displayed. See The Work 
Queue Sort Criteria Dialog.

— Filter to control which work items are displayed. See The Work Item List Filter 
Dialog.
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— Display to define which columns of information are displayed about each work 
item. See The Display Criteria Dialog.

3. Click OK when you have selected the options you want (or Cancel, to discard any 
changes).

The options you have set are applied to the current queue. If you have applied a filter the 
message [Filter ON] is displayed in red on the right hand side of the status bar.

Note: These options are saved when you exit from iProcess, and are used when 
you next log in and open the queue, either from the same or from a different 
workstation.

Tip: Use the Sort, Filter and Display options to customize your individual 
queues to suit your working practices and personal preferences. For example, 
display all queue releasable items at the top of the list, or show only urgent 
work items in order of priority.

The Work Queue Sort Criteria Dialog
You use the Work Queue Sort Criteria dialog to define the order in which work items are 
displayed. See Sort Criteria for a description of the different sort criteria that you can use.

Sort Criteria

The following table lists the sort criteria that you can use in the Work Queue Sort Criteria 
dialog box.

Sort Criteria Description

Procedure host node Node name of the system hosting the procedure that generated the 
work item.

Procedure name Name of the procedure that generated the work item, supplied by the 
procedure definer.
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Sort Criteria Description

Case number Case number of the case which the work item is part of.

Form name Name of the form that is displayed when the work item is opened, 
supplied by the procedure definer.

Arrival Date and Time Date and time when the work item arrived in the queue, in the format 
dd/mm/yyyy hh:mm.

Deadline Date and 
Time

Date and/or time when the deadline on the work item expires (if one 
is set), in the format dd/mm/yyyy hh:mm.

Case Description Text describing the case (up to 24 characters).

Priority Priority value of the work item. See Work Item Priorities.

WQ Parametern Work queue field. See Using Queue-Specific Data to Organize or 
Search Your Work Items Lists.

Deadline Items Use these criteria to sort work items according to whether or not 
they have deadlines. (Use Deadline Date and Time as well to sort 
items within these categories.) See Work Item Status Indicators.Deadline Expired 

Items

Urgent Priority Items Use these criteria to sort work items by their status. See Work Item 
Status Indicators.

Unopened items

Forwardable Items

Queue Releasable 
Items

Procedure Description Description of the procedure that generated the work item, supplied 
by the procedure definer.

Form Description Description of the form that is displayed when the work item is 
opened, supplied by the procedure definer.
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Sort Criteria Description

Queue-specific items Items containing queue-specific data, as defined by the iProcess 
administrator. See Using Queue-Specific Data to Organize or 
Search Your Work Items Lists.

The Work Item List Filter Dialog
You use the Work Item List Filter dialog to set up filters to control which work items are 
displayed. See Filter Criteria for a description of the different filter criteria that you can 
use. 

Filter Criteria

The following table lists the filter criteria that you can use in the Work Item List Filter 
dialog.

Filter Criteria Description

Host name Node name of the system hosting the procedure which generated the 
work item.

Procedure 
name

Name of the procedure which generated the work item, supplied by 
the procedure definer.

Procedure
description

Description of the procedure which generated the work item, 
supplied by the procedure definer.

Case reference Unique case reference, in the form procedure number-case number, 
of the case which the work item is part of.

Case 
description

Text describing the case (up to 24 characters).

Form name Name of the form which is displayed when the work item is opened, 
supplied by the procedure definer.
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Filter Criteria Description

Form 
description

Description of the form which is displayed when the work item is 
opened, supplied by the procedure definer.

Deadline Date and/or time when the deadline on the work item expires (if one 
is set), in the format dd/mm/yyyy hh:mm.

Priority Priority value of the work item. See Work Item Priorities.

WQ Parametern Work queue field. See Using Queue-Specific Data to Organize or 
Search Your Work Items Lists.

Queue-
specific 
items

Items containing queue-specific data, as defined by the iProcess 
administrator. See Using Queue-Specific Data to Organize or 
Search Your Work Items Lists.

The Work Item Filter For: Name Dialog

This dialog allows you to set the filter criteria for the field selected in the Work Item List 
Filter dialog (see The Work Item List Filter Dialog).

The Display Criteria Dialog
You use the Display Criteria dialog (shown below) to set up which columns of information 
are displayed about each work item in the work items list. See Display Criteria for a 
description of the different display criteria that you can use.

Display Criteria

The following table lists the display criteria that you can use in the Display Criteria dialog.

Display Criteria Description

Status Work item status. See Work Item Status Indicators.
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Display Criteria Description

Procedure Name of the procedure which generated the work item, supplied by the 
procedure definer.

Procedure 
Description

Description of the procedure which generated the work item, supplied by 
the procedure definer.

Host Node name of the system hosting the procedure which generated the 
work item.

Form Name of the form which is displayed when the work item is opened, 
supplied by the procedure definer.

Form Description Description of the form which is displayed when the work item is opened, 
supplied by the procedure definer.

Case Reference Unique case reference, in the form procedure number-case number, of 
the case which the work item is part of.

Case Case number of the case which the work item is part of.

Case Description Text describing the case (up to 24 characters).

Arrival Time Date and time when the work item arrived in the queue, in the format 
dd/mm/yyyy hh:mm.

Deadline Date and/or time when the deadline on the work item expires (if one is 
set), in the format dd/mm/yyyy hh:mm.

Starter User name of the person who started the case the work item belongs to.

Locker User name of the person who currently has the work item open 
(displayed only if the item is currently locked. See Locked Work Items.)

Priority Priority value of the work item. See Work Item Priorities.

WQ Parametern Work queue field. See Using Queue-Specific Data to Organize or 
Search Your Work Items Lists.
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Display Criteria Description

Queue-specific 
items

Columns containing queue-specific data, as defined by the iProcess 
administrator. See Using Queue-Specific Data to Organize or Search 
Your Work Items Lists.

Finding Particular Work Items
Work Queue Manager provides a powerful search facility which you can use to find 
specific work items in a work items list. 

You can do a simple search to find text in a work item’s Case Description, or use different 
or additional search criteria based on information in other columns of the work items list.

To find a particular work item, perform the following steps:

Procedure

1. Click .

The Find Work Item dialog box appears.

2. Type the characters you want to search for in the Case Description box:

If you want to use different or additional search criteria based on information in 
other columns of the work items list, click Advanced Find. The dialog expands to 
include additional search criteria - see The Expanded Find Work Item Dialog.

Note that:

— Even if a column is not displayed in your work items list, you can still use it in 
your search criteria.
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— When entering search criteria strings, you can use wildcard characters in your 
search criteria: ? will match any one character at the position it is included; * will 
match zero or more of any characters at the position it is included.

— When entering search criteria strings, there is an assumed * at the beginning 
and end of all your search criteria strings (except for case reference, which only 
has an assumed * at the beginning). For example, the search string “18965” will 
find a work item with Case Description “Invoice: 18965/a1b”.

3. Click Find Next to start the search.

The next work item in the queue that matches your search criteria is displayed. If no 
matches are found a dialog box is displayed to inform you of this.

4. Click Find Next if you want to search for the next item matching your criteria.

5. Click Close when you have finished your search.

The Expanded Find Work Item Dialog
The expanded Find Work Item dialog allows you to define different or additional search 
criteria based on information in other columns of the work items list, other than Case 
Description.

Advanced Search Criteria

The following table shows the advanced search criteria that you can use in the Advanced 
Search Criteria for: Name dialog.

Criteria Description

Case 
Description

Text describing the case (up to 24 characters), supplied when the case was 
started.

WQ Parametern Work queue field. See Using Queue-Specific Data to Organize or Search 
Your Work Items Lists.

Queue-specific 
items

Fields containing queue-specific data, as defined by the iProcess 
administrator. See Using Queue-Specific Data to Organize or Search 
Your Work Items Lists.
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Criteria Description

Priority Priority value of the work item. See Work Item Priorities.

Host name Node name of the system hosting the procedure which generated the work 
item.

Procedure name Name of the procedure which generated the work item, supplied by the 
procedure definer.

Procedure 
description

Description of the procedure which generated the work item, supplied by 
the procedure definer.

Case reference Unique case reference, in the form procedure number-case number, of the 
case which the work item is part of.

Form name Name of the form which is displayed when the work item is opened, 
supplied by the procedure definer.

Form 
description

Description of the form which is displayed when the work item is opened, 
supplied by the procedure definer.

Deadline Date and/or time when the deadline on the work item expires (if one is set), 
in the format dd/mm/yyyy hh:mm.

Using Queue-Specific Data to Organize or 
Search Your Work Items Lists
There are two types of data item that you can use to organize and search your work items 
lists, using the Work Queue Sort Criteria, Work Item List Filter, Display Criteria and Find 
Work Item dialogs described in the previous sections:

• A iProcess data item is a piece of case data that is made available by iProcess itself, 
such as Case Description or Procedure Name. iProcess data items always have the 
same name, and are available to every queue.

• A queue-specific data item is a piece of case data that is defined within a specific 
iProcess procedure, such as Invoice Number or Customer Name. The iProcess 
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administrator determines what items are available in what queues, and what their 
names are, according to the way iProcess is being used. 

iProcess provides two ways of defining and using queue-specific data:

— Work queue fields are special iProcess fields that can be used to store queue-
specific data, but are always available in the Work Queue Manager dialogs. If the 
iProcess administrator has not assigned names to these fields they are shown 
as WQ Parametern (where n is 1, 2, 3 or 4).

— Case Data Queue Parameters (CDQPs) are fields defined and assigned to queues 
by the iProcess administrator. A queue may have none of these, or many of 
these. (Only the first 50 CDQPs assigned to a queue are shown in the Display 
Criteria dialog.)

For example, you may want to be able to sort your work items by customer name, 
but also be able to search for a specific work item using its invoice number. You 
can do this if the iProcess administrator has made these items available to your 
queue, so that they appear in the relevant dialogs.

For more information about how to make queue-specific data items available in Work 
Queue Manager, see the following references:

• “Importing and Exporting Case Data Queue Parameters” in TIBCO iProcess Engine 
Administrator’s Guide explains how to define CDQPs and assign them to queues.

• “Using Work Queue Parameter Fields” in TIBCO iProcess Modeler Advanced Design 
explains how to define and use work queue fields in iProcess procedures.

• “Setting Work Queue Field Identifiers” in TIBCO iProcess Workspace (Windows) 
Manager’s Guide explains how to assign names to work queue fields to identify them 
in Work Queue Manager queues.
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Managing Your Work Queues
This section explains how to manage your work queues. 

• Updating Your Work Queues 

• The Loading Chart 

• Using Multiple Work Queue Windows 

Updating Your Work Queues
Work Queue Manager periodically (by default, every 30 seconds) checks your queues and:

• updates the lock status, priority and deadline of each work item in the currently 
open queues.

• animates queue icons in the work queues list to show that changes have occurred. 
See Setting Work Queue Manager Options.

Updating the Work Items List
When a work queue icon animates, click it to update your work items list. 

Alternatively, clicking  forces an update of your work items list. You may want to do this 

if, for example, you are waiting for a work item to arrive in the queue but do not want to 
wait for the next automatic update.

Tip: When you are working in a group queue, you should periodically update 
the work items list to capture any changes which other users have made - for 
example, to remove a work item which is marked as unavailable (because 
another user has already released it). See Work Item Status Indicators.
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Rebuilding the Work Queues List
Sometimes, a Rebuild List button appears at the top of your work queues list (as shown 
below). This means that the list of work queues you have access to has changed and could 
happen if, for example, your iProcess administrator adds you to a new group while you 
are logged in. 

Click Rebuild List and your work queue list is redisplayed. You may have additional 
queues visible or some queues may have disappeared.

The Rebuild List button disappears. 

The Loading Chart
The Work Queue Loading Chart (shown below) is a tool that shows you a graphical 
summary of your current workload across all your queues. 

Tip: Use the loading chart if your work is spread across several queues and you 
want to know where to start; or if you want an ‘at a glance’ summary of the 
contents of a very large queue.
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Click  to switch between displaying the loading chart and work items list.

The loading chart shows, in bar chart form, the following information for each visible 
work queue. (If any queues are not shown, open their folder to display them.)

• the total number of items in the queue (in green)

• the number of new items in the queue (in blue)

• the number of items in the queue which have deadlines (in red)

• the number of urgent items in the queue (in magenta).

Note: Counts and scales shown in the loading chart do not take into account 
any filters that are set on the queue.

Using Multiple Work Queue Windows
You can view and switch between all your queues in the Main Work Queue Manager 
window. However, if you prefer you can create additional windows.

Tip: Organize your desktop to show the queues you most frequently use in 
separate windows.

You can open a new window in two ways:
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• by clicking . A new Work Queue Manager window appears, with all folders 

closed.

• by double-clicking a work queue in the loading chart. A prompt appears asking if 
you want to create a new window for this queue. If you click Yes, a new window 
appears, showing the work items list for the selected queue.

You can close additional Work Queue Manager windows (in the normal way) if you no 
longer need them. Note that if you are using the Tools window, you can only minimize the 
Main Work Queue Manager window - you cannot close it.

When you log out of iProcess Workspace (Windows) your window information is saved so 
that when you next log in, all your windows will reappear in the same size and position, 
with the same queues displayed (but see the option Minimize Window on startup on 
Minimize Window on startup).

Note: If you see the message [Already Opened] on the status bar when you click 
a work queue to open it, it means that the queue is already open in another 
window. If you double click the queue the other window is activated, displaying 
the work items list for the queue.
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Managing Participant Records
This section explains how you can grant users temporary access to another user or group 
queue by creating Participant Records which record information about which users can be 
participants in a queue and for what period(s).

Note: You must be a Queue Supervisor for a Queue to be able to change its 
Participant Records.

• To Add a Participant Record

• To Modify a Participant Record

• To Delete a Participant Record

• To Unlock a Participant Record

• Redirecting Work Items

To Add a Participant Record
Procedure

1. Select the relevant queue in the Queue Administration folder on the left hand side 
of the window.

2. Click .

The Add Participant Record to Queue dialog box is displayed.

Note: Omitting the Time range will result in continuous Participation within the 
date range (as long as all days are selected).



TIBCO iProcess® Workspace (Windows) User Guide

56 | Managing Participant Records

Note: A iProcess user can have access to a maximum of 32,767 work queues. If 
this number is exceeded the user cannot log in to iProcess. Users can access 
personal, group and test queues, either directly or by supervision or 
participation.

For more information, see "How Many Work Queues Can an iProcess User 
Access?" in TIBCO iProcess Workspace (Windows) Manager's Guide.

To Modify a Participant Record
Procedure

1. Select the relevant queue in the Queue Administration folder on the left hand side 
of the window, then the relevant record in the participant records list on the right.

2. Click .

The Modify Participant Record on Queue dialog box is displayed.

Note: Omitting the Time range results in continuous Participation within the 
date range (as long as all days are selected).

To Delete a Participant Record
Procedure

1. Select the relevant queue in the Queue Administration folder on the left hand side 
of the window, then the relevant record in the participant records list on the right.

2. Click . The current record is deleted (after confirmation).

To Unlock a Participant Record
There may be occasions where a participant record has been left locked accidentally (for 
example if a client computer is powered down during editing).
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In these circumstances, iProcess Administrator users are allowed to forcibly unlock the 
item by performing the following steps:

Procedure

1. Select the locked record.

2. Click Queue > Administration, then click Unlock Participant Record from the 
submenu.

3. Click Yes in the dialog box to confirm.

Redirecting Work Items
This section explains how you can redirect all work items sent to one queue to an 
alternative queue. This could be useful, for example, when a member of staff goes on 
leave.

Note: You must be a Queue Supervisor for a Queue to be able to redirect its 
work items.

To Redirect All Work Items for a Queue
Procedure

1. Select the relevant queue in the Queue Administration folder on the left hand side 
of the window.

2. Click .

The Redirect Work Items for Queue dialog box is displayed.

Click OK and at the specified date and time all existing work items and any new work 
items that are received for that queue, are re-directed.
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Command Line Access to Work Queue 
Manager
Work Queue Manager provides a command line interface which you can use (either 
directly or from an external application) to perform the following tasks:

• Update a queue’s work items list.

• Set a filter on a work queue.

• Open a work item in a work queue.

For information about using the command line interface, see the “Starting and 
Configuring iProcess From the Command Line” topic in TIBCO iProcess® Workspace 
(Windows) Manager’s Guide.

Note: You must be logged in to iProcess to use these commands. If you are not 
already logged in to iProcess the normal login dialog box is displayed when you 
execute the command.
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TIBCO Documentation and Support Services
For information about this product, you can read the documentation, contact TIBCO 
Support, and join TIBCO Community.

How to Access TIBCO Documentation

Documentation for TIBCO products is available on the TIBCO Product Documentation 
website, mainly in HTML and PDF formats.    

The TIBCO Product Documentation website is updated frequently and is more current 
than any other documentation included with the product.    

Product-Specific Documentation

The following documentation for this product is available on the TIBCO iProcess® 
Workspace (Windows) Product Documentation page:    

 l TIBCO iProcess® Workspace (Windows) Release Notes

Read the release notes for a       list of new and changed features. This document also 
contains lists of known      issues and closed issues for this release.

 l TIBCO iProcess® Workspace (Windows) Installation

Read this manual for      instructions on site preparation and installation.

 l TIBCO iProcess Suite Documentation Library

This library contains all the       manuals for TIBCO iProcessWorkspace (Windows), TIBCO 
iProcess® Modeler,       and other TIBCO products in TIBCO iProcess Suite. The manuals 
for TIBCO iProcess® Workspace (Windows) and TIBCO iProcess® Modeler are the      
following:

• TIBCO iProcess Workspace (Windows) User Guide

• TIBCO iProcess Modeler Getting Started

• TIBCO iProcess Modeler Procedure Management

• TIBCO iProcess Modeler Basic Design

https://docs.tibco.com/
https://docs.tibco.com/
https://docs.tibco.com/products/tibco-iprocess-workspace-windows
https://docs.tibco.com/products/tibco-iprocess-workspace-windows
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• TIBCO iProcess Modeler Advanced Design

• TIBCO iProcess Modeler Integration Techniques

• TIBCO iProcess Expressions and Functions Reference Guide

• TIBCO iProcess Workspace (Windows) Manager’s Guide

• TIBCO iProcess COM Plug-in User Guide

• TIBCO iProcess Database Plug-in User Guide

• TIBCO iProcess Email Plug-in User Guide

• TIBCO iProcess Script Plug-in User Guide

• TIBCO iProcess Plug-in SDK User Guide

Other TIBCO Product Documentation

When working with TIBCO iProcess® Workspace (Windows), you may find it useful to read 
the documentation of the following TIBCO products:

 l TIBCO ActiveMatrix BusinessWorks™

 l TIBCO Business Studio™

 l TIBCO Enterprise Message Service™

 l TIBCO Hawk®

 l TIBCO Rendezvous®

How to Contact TIBCO Support

Get an overview of TIBCO Support. You can contact TIBCO Support in the following ways:    

 l For accessing the Support Knowledge Base and getting personalized content about 
products you are interested in, visit the TIBCO Support website.     

 l For creating a Support case, you must have a valid maintenance or support contract 
with TIBCO. You also need a user name and password to log in to TIBCO Support 
website. If you do not have a user name, you can request one by clicking Register 
on the website.      

http://www.tibco.com/services/support
http://www.tibco.com/services/support
http://www.tibco.com/services/support
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How to Join TIBCO Community

TIBCO Community is the official channel for TIBCO customers, partners, and employee 
subject matter experts to share and access their collective experience. TIBCO Community 
offers access to Q&A forums, product wikis, and best practices. It also offers access to 
extensions, adapters, solution accelerators, and tools that extend and enable customers to 
gain full value from TIBCO products. In addition, users can submit and vote on feature 
requests from within the      TIBCO Ideas Portal. For a free registration, go to      
TIBCO Community.    

https://ideas.tibco.com/
https://community.tibco.com/
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Legal and Third-Party Notices
SOME TIBCO SOFTWARE EMBEDS OR BUNDLES OTHER TIBCO SOFTWARE. USE OF SUCH EMBEDDED 
OR BUNDLED TIBCO SOFTWARE IS SOLELY TO ENABLE THE FUNCTIONALITY (OR PROVIDE LIMITED 
ADD-ON FUNCTIONALITY) OF THE LICENSED TIBCO SOFTWARE. THE EMBEDDED OR BUNDLED 
SOFTWARE IS NOT LICENSED TO BE USED OR ACCESSED BY ANY OTHER TIBCO SOFTWARE OR FOR 
ANY OTHER PURPOSE.        

USE OF TIBCO SOFTWARE AND THIS DOCUMENT IS SUBJECT TO THE TERMS AND CONDITIONS OF A 
LICENSE AGREEMENT FOUND IN EITHER A SEPARATELY EXECUTED SOFTWARE LICENSE 
AGREEMENT, OR, IF THERE IS NO SUCH SEPARATE AGREEMENT, THE CLICKWRAP END USER 
LICENSE AGREEMENT WHICH IS DISPLAYED DURING DOWNLOAD OR INSTALLATION OF THE 
SOFTWARE (AND WHICH IS DUPLICATED IN THE LICENSE FILE) OR IF THERE IS NO SUCH SOFTWARE 
LICENSE AGREEMENT OR CLICKWRAP END USER LICENSE AGREEMENT, THE LICENSE(S) LOCATED IN 
THE “LICENSE” FILE(S) OF THE SOFTWARE. USE OF THIS DOCUMENT IS SUBJECT TO THOSE TERMS 
AND CONDITIONS, AND YOUR USE HEREOF SHALL CONSTITUTE ACCEPTANCE OF AND AN 
AGREEMENT TO BE BOUND BY THE SAME. 

This document is subject to U.S. and international copyright laws and treaties. No part of this 
document may be reproduced in any form without the written authorization of TIBCO Software Inc.

TIBCO, the TIBCO logo, the TIBCO O logo, ActiveMatrix BusinessWorks, TIBCO Business Studio, 
Enterprise Message Service, Hawk, iProcess, and Rendezvous are either registered trademarks or 
trademarks of TIBCO Software Inc. in the United States and/or other countries.

Java and all Java based trademarks and logos are trademarks or registered trademarks of Oracle 
and/or its affiliates.

This document includes fonts that are licensed under the SIL Open Font License, Version 1.1, which 
is available at: https://scripts.sil.org/OFL

Copyright (c) Paul D. Hunt, with Reserved Font Name Source Sans Pro and Source Code Pro.

All other product and company names and marks mentioned in this document are the property of 
their respective owners and are mentioned for identification purposes only.        

This software may be available on multiple operating systems. However, not all operating system 
platforms for a specific software version are released at the same time. See the readme file for the 
availability of this software version on a specific operating system platform.

https://scripts.sil.org/OFL
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THIS DOCUMENT IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR 
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, 
FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT.

THIS DOCUMENT COULD INCLUDE TECHNICAL INACCURACIES OR TYPOGRAPHICAL ERRORS. 
CHANGES ARE PERIODICALLY ADDED TO THE INFORMATION HEREIN; THESE CHANGES WILL BE 
INCORPORATED IN NEW EDITIONS OF THIS DOCUMENT. TIBCO SOFTWARE INC. MAY MAKE 
IMPROVEMENTS AND/OR CHANGES IN THE PRODUCT(S) AND/OR THE PROGRAM(S) DESCRIBED IN 
THIS DOCUMENT AT ANY TIME.

THE CONTENTS OF THIS DOCUMENT MAY BE MODIFIED AND/OR QUALIFIED, DIRECTLY OR 
INDIRECTLY, BY OTHER DOCUMENTATION WHICH ACCOMPANIES THIS SOFTWARE, INCLUDING BUT 
NOT LIMITED TO ANY RELEASE NOTES AND "READ ME" FILES.

This and other products of TIBCO Software Inc. may be covered by registered patents. Please refer 
to TIBCO's Virtual Patent Marking document (https://www.tibco.com/patents) for details.

Copyright © 1994-2022. TIBCO Software Inc. All Rights Reserved.   

https://www.tibco.com/patents
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